Programs for American Fidelity WorxTime

There are 2 programs that can be run to create the Employee Upload File: W2WAGE and
WRXTM_EMP. These programs are located on the USPS_LCL menu or the command name
may be typed at the menu prompt.

USPS_LCL Locally Defined Programs and Utilities

86 15 Northwest Ohio Area Computer Services Cooperative Programs

. STATE_ID Listing of State ID is Numerical Order

. STRS_STATU Listing of Full/Part Flag of STRS Active Employees

. SV_B611_DED Listing of YTD totals for 611 deduction code

. SV_LABELS One wide labels of Active Employees with second line

. TSTANT Generates STRS Employee Status Report

. UNIT_PAY Listing of pay units and amounts for specific employees UDMS
. USED_BENEF Listing of Used Benefits by appointment type UDMS
. USPS_EMAIL Listing of all employees Email Addresses UDMS
. VESTED_SEVW Jfsting of Employees Vested for Severence Pay for GAAP

. W2WAGE W2 Wage Information (American Fidelity WorxTime} - UDHS

. W2_PRINT  Print W2 forms at the NOACSC

. WAGES Listing of wages paid by employee for Lima News

. WAGES_EXP Export to create wages paid by employee for Lima News

. WK_CITY_TA Wapakoneta City Tax (803) Yearly Deduction Information

Locally Defined Programs and Utilities

Northwest Ohio Area Computer Services Cooperative Programs

61." WRXTH_EMP American Fidelity WorxTime Employee Upload File
62. YTD_GROSS Listing of all employees YTD gross by decending order
Press <cr> for first screen...

Menu> w2wage

Menu>wrxtm_emp
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W2WAGE

Employee W2 Wage Information — WorxTime requires the prior year W2 wage information on
the Employee Upload file therefore this program is being run from the prior year W2 Archive
files.

This program will create an output file with the default name of W2_WAGE.CSV. This file
should be transferred (FTP’d) to your PC and saved to a secure location.

Once the employee upload file has been created for each payroll, the W2 Wage data can be
loaded to that file using the vlookup function available in Excel. For detailed instructions on how
to use this function, please reference the ‘VLOOKUP Instructions’ section of this document.

This is a screenshot of the W2WAGE program:

- W2 WAGE CSV FILE

Creates csv file containing employee id, full name, deduction code,
and taxable gross from Federal deduction record. Only selects
records wWith taxable gross greater than 0.

This was created specifically to pull the W2 wage information

for American Fidelity WorxTime Employee Upload file. The W2 wage
data for that file must be the previous year W2 amount. Therefore,
this program should be run from the appropriate HIST files. The
vlocokup function in Excel will need to be used in order to place
the W2 wage information into the appropriate column of the Employee
upleoad file.

This program can be used for other purposes than just WorxTime info
whenever a school would like to pull the taxable gross field.

Output file: W2 WAGE.CSV

WRXTM_EMP

American Fidelity WorxTime Employee Upload file — This program should be run after each
payroll has been processed. This program will create an output file with the default name of
AF_EMPLOYEE_UPLOAD.CSV and will need to be transferred to your PC then verified and
updated prior to transmitting to American Fidelity’s secure site. Please DO NOT email this file
as it contains employee SSN.

In the program you can select to include only employees with a specific job number. This works
well if your district assigns job 01 as the primary job for all employees. But you can leave this
field blank to select all jobs. You can then filter the field in Excel to remove any jobs that should
not be included in the file.
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The program also contains a prompt to allow you to select only active employees by entering the
earliest date paid you want to use. For example, if you enter 01/01/2014 in the program then only
employees whose last paid date was 1/1/14 or later will be included in the file.

The program is located in the USPS_LCL menu. Following is a screenshot:

AMERICAN FIDELITY WORXTIME EMPLOYEE UPLOAD FILE
This program will create the Employee Upload file for the American
Fidelitly WorxTime program. The file will need to be transferred
to your PC and submitted through the American Fidelity secure website.
Please DO NOT email this file as it contains employee SSN.

Qutput file: AF _EMPLOYEE UPLOAD.CSV
- Selection Options -

Enter Job Number to Select (Blank for All):
Enter Last Paid Date to Select From:

Once you open the output file in Excel, you will need to manually enter data in column N for
MeasurementGroup and column P for PayPeriodName. Column O will contain the W2 Wage
information from the previous year. Please reference the ‘VLOOKUP Instructions’ section of
this document for details.

Additional columns are included in the file beginning in column Q: Hours in Day; Retire Hours,

Last Date Paid, Job No, and Job Status. Please delete these columns unless you want to load that
information into the WorxTime system. If you want to load any of the extra columns please label
them CustomReportingl, CustomReporting2, etc.

VLOOKUP Instructions

The following instructions detail how to place the prior year W2 wage amount from the
W2_WAGE.CSV file into the Employee Upload file (AF_EMPLOYEE_UPLOAD.CSV).

Step 1

Run the W2WAGE program located in the USPS_LCL menu. This will create an output file
called W2_WAGE.CSV. Transfer (FTP) this file to your PC and save in a secure location as you
will use this same file throughout the current calendar year.

Step 2

Run the WRXTM_EMP program located in the USPS_LCL menu. This should be run against
your current files and will create an output file called AF_ EMPLOYEE_UPLOAD.CSV.
Transfer this file to your PC. DO NOT email this file as it contains employee SSN.
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Step 3

On the W2_WAGE file click on the box located to the left of column A and above the first row,
as shown in the example below. This will select the entire worksheet.

_—

( ) A B & O E
S5 FULL_MNAME DED_CODE YTD_TAMABLE GROSS
2 ATTO01223  Attricks, Geri 1 2062.5
3 BAMOOD333 Banks, Rohin 1 3080
Step 4

Click on the Formulas tab, click on Define Name, as shown in the example below. If you use an
older version of Excel, contact NOACSC Fiscal Services for instructions.

Home Insert Page Lawout Data Review Wiew Developer Acrobat
- = = Pty % . = = =) Define Mame ~
f T B EOANE 0 @ @ o
L £7 Use in Formula

Ihsert AutoSum Recently Financial Logical Text Date & Llookup &  Math Mare Mame .
Function - Used = - - - Time = Reference = & Trig = Functions = | Manager EEH Create from Selection
Function Library Defined Mames
Step 5

A box similar to the one shown below will appear. Enter MASTER in the Name box and click
OK.

Mew Mame 21X
Marme:
SCope: j
Zarmment: ;I
[~
Refers to: =wZ_wagel$1:$1045574 Eﬂ
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Step 6

In the AF_EMPLOYEE_UPLOAD file click on cell O2 as shown in the example below. This is
where you want to start placing the W2 wage value.

4l | 8] P

MeasurementGroup WEWE%E PayPeriodMame |

Step 7

Go to the Insert Function option of the Formulas tab or click on the fx symbol located next to the
formula bar.

Home Insert Page Layout Farrmulas

2 PEe@ce

Autosum Recently Financial Lu:-gu:al Text Date &
= dsed < ~ Time = F

Paagtion Library

Step 8

The Insert Function box will appear and if you have used vlookup before it should be listed in
the ‘select a function’ section if the category of ‘Most recently used’ is selected. See the example
below. If you have not used vlookup before, click on the ‘select a category’ dropdown box and
click on ‘Lookup & Reference’. In the ‘select a function’ box scroll down the list until you see
vlookup and select it. Click OK.
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nsertruncon G|

Search for a function:

Type a brief description of what you wank ko do and then click, 50 |
Go

O seleck a cateqary: [Mosk Recently Used j

Select a Function:

FREQUEMNCY
COUNTIF

COUNT
AVERAGE |

YLOOKUP{lookup_valuetable_array,col_index_num,range_lookup)

Loaks for a walue in the leftmaost column of a kable, and then returns a value in the
same rovw Fram a column wou specify, By defaulk, the table must be sorted in an
ascending order,

Help on this funckion ik, I Zancel

Step 9
The Function Arguments box will appear. Fill it in as follows:

Lookup_value = A2 (This is the value you want to lookup. In this example, it is from the
AF_employee__upload table. This value must be in the 1 column.)

Table_array = (This is the table where the value being searched is found.) Either type in
w2_wage.csvIMASTER or you can switch over to the W2_Wage file and click on the box
between column A and row 1. Also, you can type in the exact location of the file. Ex.
(‘h:w2_wage.csv’!master) In this example, h is the drive where the file is stored.

Col_index_num = 4 (this represents column 4 or column D of the W2_Wage file which contains
the W2 wage value.) ex. (col_index_num =1 would be column A, col_index_num = 2 would be
column B.

Range_lookup = False (this will cause the value of N/A to be entered in column O of the
AF_EMPLOYEE_UPLOAD file when there is no matching employee ID between the 2 files.)
The value of False makes it look for an exact match.
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Function Arguments

LOOKLP
Lookup_value |4z 8] = "aBRADO0OL"
Table_array |[wZ_wage.csvwZ_wagelMASTER 8] = {.}
Col_index_num |4 Eﬂ = 4
=
Range_lookup IFalse J':ﬂ = FALSE
= 10044.92

Lonks For a walue in the leftmost column of a kable, and then returns a value in the same row From a calumn you
specify. By default, the table must be sorted in an ascending order.

Range_lookup is alogical value: to find the closest match in the First column (sorted in
ascending order) = TRUE or omitted; find an exact match = FALSE.

Formula result = 10044,92

Helo on khis Funckion K I Zancel

When you click OK, cell O2 will fill in with a value.

Step 10

To populate the rest of column O, double-click on the square in the lower right corner of cell O2.
This will automatically copy the formula down the column.

4 | o P

MeasurementGroup W2Wage PayPeriodMame |
I 2[!52.5!

Step 11

Now you will need to change the formula in that column to the value. You can see the formula is
contained in cell O2 below.

SLOCKLUP (A2, w2 wage, csvl MASTER, 4,0)
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Click on column O to select it.

3

4 8] F
E MeasurementGroup |W2Wage [PayPeriodMName H
20825
anan
415
2112.5

Right click to select COPY

Calibi » 11« A" A7 $ v % v [

(S - P Q
ip [waw & cu lours In Day Retir
30 53y copy 4mED 5
i [, Paste Options: 8

Click on cell O1, right click and select Paste Values

Calibi = 11 = A" A7 % - %
B JEMO-A-imi-510

Past i | 4
Walues ]
Thze 1=
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Now the cell contains just the value.

2062.5

TermDt MeasurementG WiltWage F
2

Step 12

Next, if you have values of N/A in the column, use the filter on the Home tab to display those

[RyT ——

—mm jh i 2 Aytoium v W ﬁ
& & Fill -

Insert Delete Format Sort & | Find &
- - + | 2 Clear™  [Fifbere|select -
Cells Edil %l El:lrt.":".tl:l 7

2l sontZtos
E Custam Sart.,

W= Filter -
] R Q
p W2Wage PayPeriodName Hours | .
1004452
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it

S TermbDt |« | MeasurementGral « M2 ar = |F

i

8]

] ‘El Sork Smallest to Largest
L i,l, Sort Largest to Smallest

Lot by Color

Murber Filkers

Search

~[196277.18
-[]98209,95
-[]98998,67
-[]100649,52
~[1103138.8
-1 106069,94
-[1108609,13
~[1128577.72
~[1129348.26

[ R .

RS

4

014 I Cancel |

L T R Y i R R I i R R R )

A

Change the value in the first cell to 0 then double-click on the square in the lower right corner of

the cell to paste it automatically to the remainder of the column.

M

[cT— E

MeasurementGrou = | W2Wal-T PayPeriodMar) = |+

0

s S~

HMF A
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Remove the filter

Ml i | i
r TermDt | = heasurementGrol « | W2 a1 | |
3 ‘El Sort Smallestto Largest

41 %] sortLargest to smallest

3 Sort by Calor ;
Fil

P % Clear Filter Fram "wW2wWage"

3

4 ¥ | Mumber Filkers -
q Search o)
; -
G

4

Fil

Step 13

Now you can format the column to Number so it displays the decimal point and two decimals.
Don’t use commas.

I =
0
Zut
) (L 'ﬁ B alnl
= l:
ez = =P
2080 Fe) P.aste Options:
415 =
211z Paste Special...
2185 Insert
2062
Delete
230cC
941 Clear Cantents
215 f]"' Format CEIIS...-
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Format Cells |

Murnber | Alignrmenkt | Fonk | Border I Fill | Prokection I
Category:
|General ~| [3ample
bRl
Currency e
Accounting . , Y
Dats Decimal places: |2 5
Tirne ™ Use 1000 Separator (5
Percentage
Frackion Megative numbers:
Scentic T |
Text 1234.10
Special {1234.10)
Custom {1z34.10)
Ll j
Mumber is used for general display of numbers, Currency and Accounking affer specialized
Formatking Far monetary value,
(0] 4 I Cancel
T ===
[ ] F
[ MeasurementGroup IWEWaéE _lF'aﬁ,fF'ern:udName t
2062.50
a0a0.00
415.00

Step 14

Review the entire spreadsheet and make sure you entered data in column N for
MeasurementGroup and column P for PayPeriodName. Also make sure you delete any additional
columns after column P if you don’t want to include them in the WorxTime system. If you do
want to keep any of the extra columns please label them CustomReportingl, CustomReporting?2,
etc.
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Step 15

If everything looks good, save the spreadsheet in csv format. Upload the CSV file to the
American Fidelity secure site.

Hours Upload File

At this time it is recommended that the AFFORD program csv output file be used for the Hours
Upload file. Below is a screenshot of the AFFORD program options. Enter the pay period date
range and mark the insurance flag with ‘N’.

AFFORD - Affordable Care Act Reporting

Report File Specifications:
Print options page? (Y/N): Y

Sort Options:
Sort: ID

Selection Criteria:

Beginning Date: 05/06/2014

Ending Date: 05/20/2014

Exclude based on termination date? (Y/N): Y

Exclude employees with insurance? (Y/N): N

Calculate based on number of weeks or months? (W/M): W

Calendar for calculating breaks:

Retrieve retire hours from histor 1 of 2

Transfer the AFFORD.CSV file to your PC. Remove all of the columns except what is required
as shown below. Change the column headings to match what is listed here.

EIN  (this is the SSN)
LastName

FirstName
PayPeriodEndDate
HoursWorked

If you need any assistance please contact NOACSC Fiscal Services.

Page 13 of 13



